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Designing a mold base 
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Splitting a model 

1. Use the Mold Die Wizard

1 Click Module from the Main menu. 

2 Make sure  is displayed next to Toolmaker. 

If  is not displayed, click on Toolmaker to activate the module. 

3 Click Import Data (Moldbase.psmodel). 
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4 Click View ISO1 using the right mouse button .  

 

5 From the flyout, click View ISO3 . 
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The model shown below is displayed in the graphics window. 

 

6 Click on the model to select it. 

 

7 Click Wizards . 

 

8 Click Start Mold Die Wizard .  

9 The Mold Die Wizard dialog is displayed.  
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 is displayed next to Product to show the model is selected. 

 

10 Click Next. 

 You can create curves and surfaces around holes that need 

to have shut off surfaces added into them so that the model 
splits successfully. 

11 Click Add split line/surface selection . 
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12 Select Surfaces from the Using list. 

 

13 Click Zoom to box Mode .  

14 Click the left mouse button and drag a box, as shown: 
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15 Click the face shown below: 

 

16 Hold down the Shift key and click the two faces shown below: 
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Your model should look like the one shown below: 

 

Three new split lines are created and the dialog shown below is 

displayed. 

 

17 Click Next. 

This page of the wizard allows the shut off surfaces to be edited 

to create the best surface. 
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18 Select curve 2 from the Tangent list. 

 

19 Hold down the Control key and select curves 3 and 8. 

 

20 Click Make the selected fill-in(s) non-tangent .  
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This makes the curves non-tangent.  

 

21 Click Next. 

This page is where you can add an offset to the cavity and core 
to allow for shrinkage. 

 

22 Click Next. 
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This page of the wizard is where you define the length and width 

of the cavity and core blocks. 

 

23 Click the Set minimum land dimensions  button. 

 

24 Set the Product Offset Y to 5. 

25 Set the Block Width to 25. 

26 Set the Block Length to 25. 
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The values are associated to each other so the block size is now 

displayed as shown in the wizard. 

 

27 Click Next. 

You can edit and refine the construction of the split surface 

between the cavity and core on this page. 

28 Click Advanced split surface options . 

The Advanced split surface options allow the removal of creases in 

the split surface. 
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The Split Segments dialog is displayed. 

 

29 Do the following: 

 Click Go both directions? . 

 Click Clear. 
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30 Click View from Top . 

 

31 Click the 4 break points at the positions shown below 
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32 Your model should look like the one shown below: 
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33 Click the Insert Breakpoints option to deselect it. 

 

34 Do the following: 

 Select Along Axis from the Split Direction option.  

 Select Y as the direction. 
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This points the direction arrow of the split surface away from the 

model as shown in the image below: 

 

35 Repeat for Current Segments 2, 3, and 4. 

 Always ensure the arrow points away from the model. 

 The Along Axis direction is either x or y. 

36 Click OK. 
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Your model should look like the one shown below: 

 

37 Click Next. 

 This page of the wizard is where you define the height of the 

cavity and core blocks. 
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38 Enter an Overall height of 110. 

 

39 Click Next. 

 On this page of the wizard, you can specify the corners of 

the blocks to have one of the following options:   

 fillets 

 chamfers  

 nothing 

 define each corner individually 

 

40 Click Next. 
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 Before the cavity and core blocks are finally calculated, the 

simulation will split them apart so the blocks can be visualized 

and checked for changes. 
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41 Click View ISO1 using the right mouse button .  

 

42 From the flyout, click View ISO3 . 
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43 Drag the Separate core and cavity by: slider to 100. 

 

The cavity and core are shown separated. 

 

44 Click Finish. 
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The model has been taken and the split line found automatically. 

From this the cavity and core blocks have been created. 
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Creating a mold base 

2. Use the Cavity Core Wizard

1 Click Import Data (Moldbase_2.psmodel). 

The model shown below is displayed in the graphics window. 

2 Click Module from the Main menu. 

3 Make sure  is displayed next to Toolmaker. 

If  is not displayed, click on Toolmaker to activate the module. 

4 Click Wizards . 
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5 Click Start Cavity Core Wizard  . 

 

The Cavity Core Wizard is displayed n the browser window. 
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6 Select the Non-inserted core/cavity plates option. 

 

7 Click Wireframe View . 

The cavity and core plates need to be registered. 

8 Click Zoom to box Mode .  
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Click the left mouse button and drag a box, as shown: 

 

9 Click the workplane shown in the image below. 
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 is displayed next to Select workplane. 
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10 Click Resize to Fit . 
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11 Select Select cavity solid. 
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12 Click the cavity shown in the image below: 
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 is displayed next to Select cavity solid. 
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13 Click Select core solid. 
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14 Click the core shown in the image below: 
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 is displayed next to Select core solid. 
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15 Click Shaded and Wireframe view . 
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16 Click Register. 

 

The next page of the wizard is displayed. 

 

17 Click Next. 
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The next page of the wizard is displayed. 

 

18 Do the following: 

 Select Hasco from the Catalog drop down list. 

 Change the Material for the Cavity plate to 1730. 
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 Change the Material for the Core plate to 1730. 

 

The cavity and the core plate are displayed in the model window. 
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19 Click Next. 
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20 Click Next. 
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21 Click Next. 
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The plates are drawn with the model. 

 

22 Click Finish. 

This completes the Cavity Core Wizard.  
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The Mold Base Wizard starts. 

 

The mold base is drawn in the model. 
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23 Click Resize to Fit . 
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Your model should look like the one shown below: 
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24 Click Support plate to deselect it. 

 

25 Click Next. 
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All the components are displayed on the model. 

 

26 Do the following: 

 Select Guide pillars. 
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 Click Dimensions. 
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The Component Wizard is displayed, shown in the image below: 

 

27 Do the following: 

 Select Custom tab. 



 

52 • Designing a mold base PowerSHAPE 2016 R1 Tutorials Manual  

 Change Body length S2 to 190. 

 

28 Click OK. 

29 Do the following: 

 Select Guide bushes. 
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 Click Dimensions. 

 

The Component Wizard is displayed. 

30 Do the following: 

 Select Custom tab. 
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 Change the Length S2 to 95. 

 

The guide pillars and guide bushes have been adjusted to fit one 

side of the split line. The other side will be done manually, later. 

31 Click OK 

32 Click Next. 
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The summary is displayed. 

 

33 Click Finish. 
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The mold base is created from components and have been added 

into an assembly. 

 

The components in the mold base are displayed in the tree 

window. 

 Click  to expand the tree. 
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34 Click Guide pillar (40 165 190 54) User defined_2 using the right 

mouse button. 
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35 Select Modify > Parameters. 

 

The parameter page of the wizard is displayed. 
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36 Change S2 to 220 

 

37 Click Apply. 

38 Click Dismiss. 
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39 Click Guide bush (40 95 42) User defined_2 using the right mouse 

button. 
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40 Select Modify > Parameters. 

 

The parameter page of the wizard is displayed. 

41 Change S2 to 65. 

 

42 Click Apply. 
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43 Click Dismiss. 

 

44 Repeat steps 35 to 43 for the following components: 

 Guide pillar (40 165 222 54) User defined_3. 

 Guide bush (40 95 54) User defined_3. 

Your model should look like the one shown below: 
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Creating a mold lock 

3. Use the Mold Lock Wizard

1 Click Import Data (Moldbase_3.psmodel). 

2 Click Module from the Main menu. 

3 Make sure  is displayed next to Toolmaker. 

4 If  is not displayed, click on Toolmaker to activate the module. 

5 Click Wizards . 
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6 Click Start Mold Lock Wizard .  

 

7 The Mold Lock Wizard dialog is displayed. 

 Mold locks are added to a mold base to keep the cavity and 

core plates in position so that they cannot move and destroy the 
part when it is created. 
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The cavity and core are selected and stored in the wizard. 

8 Select the cavity plate shown below: 

  

The cross  icon changes to a tick  icon.next to Select the 

cavity. 
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9 Click Select the core. 

 

10 Select the core plate shown below: 

  

11  changes to  next to Select the core. 

12 Click Next. 

 This page of the wizard is where the position and 

dimensions of the mold locks are defined. 
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13 Select the four corner layout shown below: 

 

14 A preview of the mold locks are displayed on the model.  

The mold locks are numbered 1 to 4.   

1 is the active mold lock. 
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15 Change all the Clearances to 1. 

 

16 Click Display the solid pocket dialog . 
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17 The Protrusion dialog is displayed. 
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18 Change the Dimensions to those shown on the image below: 

 

19 Do the following: 

 Click the Corners tab. 
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 Change the Corner value to 35, shown in the image below: 

 

20 Do the following: 

 Click the Fillets tab. 
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 Change the value of the Fillets shown in the image below: 

 

21 Click OK. 

22 Click Constant/variable z level for male halves . 

 



 

74 • Designing a mold base PowerSHAPE 2016 R1 Tutorials Manual  

The model updates showing the different heights of the mold 

locks. 

 

23 Click Finish. 
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24 Click View from Front . 
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Your model should look like the one shown below: 

 

This shows how the mold locks have been changed so that they 
are the same height, even though the split line is variable. 
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Creating a slide core and slide 
mechanism 

4. Use the Slide Core Wizard

1 Click Import Data (Moldbase_4.psmodel). 

2 Click Module from the Main menu. 

3 Make sure  is displayed next to Toolmaker. 

4 If  is not displayed, click on Toolmaker to activate the module. 
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5 From the Status Bar at the bottom of the screen, click the Z 

principal plane. 

 

6 Click Workplane . 

7 Click Single workplane . 

 

8 Click on the model shown in the image below: 

 

9 Click Edit > Modify..  
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The Workplane dialog is displayed. 

10 Click Twist around Y. 

 

The Calculator is displayed. 

11 Enter -90. 

 

12 Click OK. 
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13 Click OK. 

 

The workplane is now in the correct direction to create the slide 
core. 

 The Z axis must point away from the model in the direction 

that the slide will move. The X axis is in the split direction of the 

model and points towards the top of the slide. 

14 Click Wizards . 
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15 Click Start Slide Wizard . 

 

16 The Slide Wizard starts. 

The Create a slide core.. option is already selected. 
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17 Click the Start Slide Core Wizard option. 

 

The type of core required for the mold is selected. 
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18 Click Next. 

The cavity and core plates are stored into the wizard. 

 

19 Click the core plate as shown below. 

 

The cross  icon changes to a tick  icon. 

20 Click Select the Cavity. 
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21 Click the cavity plate shown below: 

 

The cross  icon changes to a tick  icon. 

22 Click Next. 
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The split surfaces of the cavity and core plates have to be 

selected. 

 

23 Click Group levels Fixed Half and Moving Half to turn them off.  

 

24 Click Single Face from the Selection Method drop down list. 

 

 You only need to select the split faces that surround the 

undercut. 
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25 Hold down the Shift key and click the four faces shown below; 

 

The cross  icon changes to a tick  icon. 

26 Click Cavity. 
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27 Click the middle mouse button and rotate the model so it looks 

like below. 

 

28 Hold down the Shift key and click the four faces shown below; 

 

The cross  icon changes to a tick  icon. 

29 Click Next. 
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The undercut region is selected. 

 

 You only need to select the faces that create a box that 

covers the undercut. 

30 Click Last view . 

31 Click Single Face from the Selection Method drop down list. 
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32 Click Level 5 to turn it off. 

 

33 Click Zoom to box Mode .  

34 Click the left mouse button and drag a box, as shown: 

 

35 Click Wireframe View . 

36 Hold down the Shift key and click on the two fillets shown below: 
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The two fillets (shaded for identification) should be selected. 
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37 Click Shaded and Wireframe view . 

 

38 Click Last view .  

39 Click Group levels Fixed half and Moving half to turn them on. 

40 Click Level 5 to turn it on. 
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Your model should look like the one shown below: 

 

41 Click Next. 

The outer shape of the slide core is created from one of the 

following: 

 A user defined curve projected onto the model. 

 An automatically generated curve.  

A draft angle can also be added. 

42 Select the Auto-Generate Method.  
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 This option may be selected already. 

 

43 Do the following:  

 Change the Slide Core Draft Angle to 0. 

 Change the Oversize to 2.5. 

 Change the Maximum Radius to 45. 

 Change the Minimum Angle to 10. 
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44 Click Resize to Fit . 

 

45 Click Next. 

This page of the wizard is where the final dimensions of the slide 

core are specified. These dimensions define how the slide core 
interacts with the split surfaces of the cavity and core blocks. 

46 Do the following: 

 Select the Zero draft on slide core base option. 

 Change the Reference to the Slide core front option. 

 Change the Slide Core length to 50. 
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47 Click Finish. 

Your model should look like the one shown below: 

 

48 Click Register. 
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This creates a component of the slide core and adds it to the 

assembly. 

 

49 Click Cancel. 
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5. Use the Slide Mechanism Wizard

1 Click Import Data (Moldbase_5.psmodel). 

2 Click Module from the Main menu. 

3 Make sure  is displayed next to Toolmaker. 

4 If  is not displayed, click on Toolmaker to activate the module. 

5 Click Wizards . 
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6 Click Slide Wizard . 

 

The Slide Wizard starts. This wizard is used to design the 

mechanism that removes the slide core and adds it to the mold 
base. 

7 Click the Design slide mechanisms.. option. 
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8 Click Next. 
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9 Select Type A. 

 

10 Click Next. 

The Component Wizard is displayed. 

11 Select Slide Mechanism Tutorial from the Catalog Reference. 
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This contains predefined sizes to fit the model. 

 

12 Click OK. 
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The Slide Wizard remains displayed in the Browser 
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13 Scroll down the wizard and change the Vertical Offset to -10. 
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14 Scroll back up the wizard and click on the Heel block, shown 

below: 
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The Heel Block page of the wizard is displayed. 
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15 Change the Heel Block Edge Height to 50. 
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16 Scroll back up in the wizard and click on the angle pin shown 

below: 

 

The Angle Pin page of the wizard is displayed. 
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17 Scroll down in the wizard, and click Number of angle pin(s) 2. 

18 Enter the values shown in the image below: 
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A preview of the slide mechanism is shown on the model. 

 

19 Click Next. 
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20 Scroll down and select the Insert a wear plate.option. 
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21 Change the values in the wizard to match the image shown 

below: 
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22 Click Next. 

 

23 Select Blind in the Slide Pocket options. 
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24 Click Next. 

 

25 Click Next. 

26 Click View ISO1 .  
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Your model should look like the one shown below: 
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Creating cooling holes 

6. Use the Cooling Wizard

1 Click Import Data (Moldbase_6.psmodel). 

 Make sure the World workplane is selected. 

2 Click Module from the Main menu. 

3 Make sure  is displayed next to Toolmaker.  

4 If  is not displayed, click on Toolmaker to activate the module. 

5 Click Wizards . 
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6 Click Start Cooling Wizard . 

 

7 The Cooling Wizard starts. 

The Cooling Wizard is used to define the layout and dimensions of 

the holes for the cooling system.  
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 Use this page of the wizard to select the plates where the 

cooling holes will be created. 

 

8 Select the Fixed Half - automatic selection option. 
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The cavity plate is selected. 

 

9 Click Next.  

 This page of the wizard is where the hole types are selected. 
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10 Change the values to match the wizard shown below: 

 

11 Click Next. 

 This page of the wizard is where you define the layout of the 

holes. 

 

12 Enter a Depth of 145. 

The cooling track is now sketched over the plate. 
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13 Click View from Top . 
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Your model should look like the one shown below: 

 

14 Move the cursor over the model at approximately the position 
shown in the image below. 
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15 When Grid is displayed and -450 -150 0 is displayed in the status 

bar, click with the left mouse button. 

 

16 Move the cursor over the model at approximately the position 

shown in the image below. 
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17 When the cursor displays Grid, 740 and 290 -150 0 in the status 

bar., click with the left mouse button. 

 

18 Move the cursor over the model at approximately the position 

shown in the image below. 
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19 When the cursor displays Grid and 520, click with the left mouse 

button. 

 

20 Move the cursor over the last point entered.  
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21 When the cursor displays L:0 and the stop sign, click with the left 

mouse button. 

 

This finishes the line. A new line can now be created anywhere. 

22 Move the cursor over the model at approximately the position 
shown in the image below. 
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23 When the cursor displays Grid and -450 150 0 in the status bar, 

click with the left mouse button. 

 

24 Move the cursor over the model at approximately the position 

shown in the image below. 
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25 Click with the left mouse button. 

 

26 Move the cursor over the last point entered.  
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27 When the cursor displays L:0 and the stop sign, click with the left 

mouse button. 

 

 Rotate the view to make sure that the lines you create do 

not touch the pillars or the model in the middle of the plate.  
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28 Click Edit Cooling Holes . 

 

The holes are drawn on the model. 
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29 Click the two horizontal lines that were created whilst holding 

down the shift key so that both holes are selected. 

 

30 Click Raise editing form . 

 

The Edit selected Hole(s) dialog is displayed. 
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31 From the Start drop down list, select the Cooling Connector 

(Counterbored With Tapped) option. 

 

32 Click OK. 

The two holes are now drawn with Cooling Connector 

(Counterbored With Tapped) holes. 
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33 Click Next. 

The cooling holes can now be checked to see if they collide with 

any other geometry and edited if they do. 

34 Click Check, shown in the image below: 
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35 A message is displayed reporting that none of the holes had 

errors. 

 

 If any cooling holes are reported with errors, go Back in the 

Wizard to edit the layout of the cooling holes to make sure they 

do not touch the pillars or the model.  

36 Click OK. 

37 Click Check, shown in the image below: 

 

The cross  icon changes to a tick  icon.. This indicates there 

are no problems with the holes. 
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38 Click Next. 

 Use the options on this page of the wizard to save the error 

curves and the layout of the cooling holes. These can be used to 

make changes to the mold base if required. 

  

39 Click Finish. 
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40 Your model should look like the one shown below: 

 

41 Change the view to see all of the mold base. 
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42 Click View ISO1 .  
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Your model should look like the one shown below: 
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Creating Components 

7. Use the Component Wizard

1 Click Import Data (Moldbase_7.psmodel). 

2 Click Module from the Main menu. 

3 Make sure  is displayed next to Toolmaker. 

4 If  is not displayed, click on Toolmaker to activate the module. 
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5 Click Assembly . 

6 Click Component Wizard .  

 

The Component Wizard starts and the Choose a component dialog 

is displayed. 

 

7 Do the following: 

 Select HASCO from the Standard Catalogs. 
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 Click  to expand Ejection components. 

 Select Ejector pin (Z41). 

 

8 The Ejector pin (Z41) component is displayed, shown in the image 

below: 

 

9 Click OK. 

10 Do the following: 

 Select a Shank Diameter of 8. 
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 Select 500 for the Length. 

 

11 Do the following: 

 Select the Key & Trim tab. 

 Select Double from the Key drop down list. 
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 Select Far from the Face drop down list. 

 

12 Click Apply. 

13 Click in the Command Input box in the Status Bar and type: 

50 90 0 

 

14 Press Enter. 
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A pin is created on the model. 

 

15 Click in the Command Input box in the Status Bar and type: 

-50 90 0 

 

16 Press Enter. 
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A second pin is created on the model. 

 

 These pins were created with the Automatic Trim option 

turned ON. So, when you Dismiss the form they are 

automatically trimmed to the model. 

17 Click Dismiss. 
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18 Select the Trim Pin option to deselect it.  

 

 When the pin is created this time it will not be trimmed to 

the model. 

19 Click Apply. 

20 Click in the Command Input box in the Status Bar and type: 

260 40 0 

 

21 Press Enter. 
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A pin is created on the model. 

 

22 Click Dismiss. 

23 Click Dismiss. 
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24 Click View from Front . 
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Your model should look like the one shown below: 

 

The two trimmed pins and one untrimmed pin can now be seen. 
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25 Click each pin with the left mouse button whilst holding down the 

Shift key to select them. 

 

26 Click Show General Edits Options . 
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 Keep clicking the button until the toolbar shown below is 

displayed. 
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27 Click Mirror/symmetrise object . 

 

The Mirror toolbar is displayed. 

 

28 Click Mirror in ZX  . 

 

29 Click Apply . 

30 Click Select . 
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31 Click View ISO1 .  
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Your model should look like the one shown below: 

 

This has mirrored the set of pins. 

32 Click anywhere in the graphics window to deselect the model. 
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33 Hold down the Shift key and click the two untrimmed pins using 

the left mouse button, shown in the image below. 

 

34 Click Wizards . 
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35 Click Power Feature Trimming . 

 



 

PowerSHAPE 2016 R1 Tutorials Manual Designing a mold base • 159  

The Wizard starts. 

 

Automatic settings is selected. 
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A tick is displayed to show components are selected. 

 

36 Click Trim. 

37 Click Dismiss. 
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The two pins are now trimmed to the model. 

38 Click anywhere in the graphics window to deselect the model. 
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39 All six pins are now ready to have their Power features 
generated. This will create holes through the plates for the pins. 

40 Do the following: 

 Click on Moldbase in the tree window using the right mouse 

button. 

 Select Power Features. 
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 Select Generate. 

 

The holes have now been created in the plates. 

 
 

Summary 
You have created a mold base ready for production. 
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You have done the following: 

 Split a model using the mold die wizard  

 Created a mold base using the cavity core wizard  

 Added mold locks to the cavity and core plates  

 Added a slide core and mechanism to the undercut region  

 Created cooling holes  

 Added extra components  
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